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1. Dulezité

Tato elektronickd uZivatelskd prirucka je
uréena pro kazdého uZivatele tohoto monitoru
Philips. Pred pouZzivdnim monitoru si prectéte
tuto uZivatelskou prirucku. Obsahuje ddlezité
informace a poznamky k pouzivani vaseho
monitoru.

Zaruka Philips je platnd, pokud je vyrobek
pouzivdn pro navrzenou potrebu v souladu

s ndvodem a po priloZen( origindlu faktury
nebo pokladnim dokladem, oznacujicim datum
ndkupu, jméno prodejce a modelové a vyrobnf
¢islo vyrobku.

1.1 Bezpecnostni opatreni a udrzba

€ Varovani

Pouziti kontrol, Uprav nebo postupl jinym

zpUsobem nez je stanoveno v této dokumentaci

muze vést k ohroZenf Sokem, elektrickym a/

nebo mechanickym rizikdim.

Prectéte si a dodrzujte tyto instrukce pri

zapojovani a pouzivan( vaseho PC monitoru.

Pouzivani

*  Nevystavujte monitor prfimému slunecnimu
zdrenf, velmi silnym jasnym svétldm a
udrzujte jej mimo dosah jinych zdrojl tepla.
Dlouhé vystaveni tomuto typu prostredf

muZe mit za nasledek zménu barev a
poskozeni monitoru.

»  Odstrarite veskeré predméty, které by
mohly spadnout do vétracich otvord nebo
zabranit dostatecnému chlazeni elektroniky
monitoru.

*  Nezakryvejte vétracl otvory ve skffice.

*  Umlistéte monitor na takové misto, ze
kterého bude elektrickd zdstrcka a zdsuvka
snadno pristupna.

* Jestlize jste vypnuli monitor odpojenim
napdjectho kabelu nebo kabelu napdjeciho
adaptéru, pred pripojenim kabelu pockejte
6 sekund, aby monitor fungoval normainé.

* Vidy pouzivejte napdjeci kabel schvéleny
spolecnostf Philips. Pokud napd jeci kabel
chybi, obratte se na nejblizsi servisni
stredisko. (Viz informace o strediscich
zékaznické péce)

*  Béhem pouzivdni nevystavujte monitor
nadmémym otresim nebo ndrazim.

* Pfi pouzivani nebo premistovéni do
monitoru nekopejte a zabrarite pripadnému
padu.

Udrzba

*  Aby byl monitor chrdnén pred moznym
poskozenim, nevyvijejte na panel LCD
nadmémy tlak. Pri premistovani zvedejte
monitor za rdm; pfi zveddni monitoru
nesahejte rukou nebo prsty na panel LCD.

* Nebudete-li monitor delsf dobu pouzivat,
odpojte jej ze zasuvky.

* Pred ocisténim mime navihéenym
hadrfkem monitor odpojte ze zdsuvky.
Je-li vypnuté napdjent, Ize obrazovku otrit
suchym hadrikem. K ¢isténi monitoru nikdy
nepouzivejte organickd rozpoustédla, jako
napfiklad alkohol nebo Eistice s obsahem
¢pavku.

» Zabrarite nebezpedf Urazu elektrickym
proudem nebo trvalého poskozenf
monitoru a chrarite monitor pried prachem,
destém, vodou nebo nadmérné vihkym
prostredim.

* Pokud dojde k namoceni monitoru, co
nejdrive jej osuste suchym hadrikem.

*  Vnikne-li do monitoru cizf ldtka nebo voda,
ihned vypnéte napdjeni a odpojte napdjecl
kabel. Odstrarite cizf ldtku nebo vodu
z monitoru a odeslete jej do servisniho
strediska.

*  Monitor neskladujte ani nepouzivejte
na mistech vystavenych teplu, pfimému
slunecnimu zdreni nebo extrémnim
teplotdm.

*  Chcete-li zachovat optimdlni vykonnost
monitoru a prodlouZit jeho Zivotnost,
pouzivejte jej na misté, které splfiuje
ndsledujici rozsahy teplot a vihkosti.



* Teplota: 0-40°C 32-95°F
e Vlhkost: 20-80% relativni vihkosti

Dulezité informace pro vypaleni obrazu/
zdvojeného dosvitu

* Pred ponechdnim monitoru bez dozoru
vzdy aktivujte spori¢ obrazovky. Bude-li
na vasem monitoru zobrazen neménicf
se staticky obsah, vzdy aktivujte aplikaci
pro pravidelnou obnovu obrazovky.
Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu mize
zpUsobit ,,vypdleni* obrazovky, rovnéz
zndmé jako ,,dosvit" nebo ,,zobrazenf
duchd”.
, Vypéleni*, ,dosvit" nebo ,zobrazenf
duchd" je dobre zndmy jev u technologie
panell LCD. V mnoha pripadech , vypdleni,
,,dosvit"* nebo ,,zobrazeni duchld* postupné
zmizi po urcité dobé mimo provoz.

(D Vystraha

Selhanf aktivace sporic¢e obrazovky nebo aplikace
pro pravidelné aktualizovdni obrazovky mdze mift
za ndsledek vdzné priznaky ,vypdleni*, , dosvitu"
nebo ,zdvojeného dosvitu®, které nezmizi a
nelze je opravit. Na vySe uvedené poskozen( se
nevztahuje zdruka..

Servis

* Kyt pldsté mdze oteviit pouze kvalifikovany
servisni pracovnik.

* Pokud je pro opravu vyzadovana
dokumentace nebo integrace, obratte se
na nejblizsi servisni stredisko. (Viz kapitola
,,Stredisko zdkaznické péce')

* Informace o preevdzeni najdete v ¢ésti
,, Technické Udaje".

* Neponechdvejte monitor v auté nebo v
zavazadlovém prostoru auta na primém
slunci.

© Poznimka

Pokud monitor nefunguje spravné nebo pokud
si nejste jisti, jaké kroky je treba provést po
provedeni pokynU v této prirucce, obrat'te se na
servisniho pracovnika.

1.2 Vysvétleni zapisu

Nasledujici pododdily popisujf zplsob zdpisu,
ktery se pouzivd v této prirucce.

Poznamky, upozornéni a vystrahy

Na strdnkdch této prirucky mizete narazit na
text, ktery je opatfeny symbolem a je vytistén
tucné nebo kurzivou. Takové useky obsahujf
pozndmky, upozornéni a vystrahy. Jejich pouZitf
je nasledujict:

€& Pozniamka

Tento symbol oznacuje dlleZité informace a
ndvrhy, které poméhajf Iépe vyuzit pocitacovy
systém.

© Upozornéni

Tento symbol oznacuje informace, které
objasniujf, jak se vyhnout moznému poskozenf
zafizeni nebo ztrdté dat.

D Vystraha

Tento symbol oznacuje nebezped( télesného
ubliZzenf a vysvétluje, jak se danému problému
vyhnout.

Nekteré vystrahy se mohou objevit v rizné
podobé a nemusf byt uvozeny symbolem.V
takovém pripade je konkrétni vyznacenf vystrahy
nar{zeno Uradem pro regulaci.



1.3 Likvidace produktu a obalového
materialu

Likvidace elektrickych a elektronickych
zarizeni - WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2012/19/EU governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation innational take-back initiatives

and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and
related packaging material) in accordance with
all Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page


http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page

2. Sestaveni monitoru 2] Namontujte stojanek podstavce

1.

2.1 Instalace

El Obsah krabice

Z
Start

- oo PHILIPS

*V zavislosti na zemi

3.

Umistéte monitor obrazovkou dold na
mékky a hladky podklad, aby nedoslo k
poskrdbani obrazovky.

Pripojte sloupek podstavce k monitoru tak,
aby zaklapl do pozice.

Uchopte monitor obéma rukama a
pripevnéte stojanek podstavce do sloupku
podstavce.




H Pripojeni k pocitaci

(1) Vstup stfidavého napdjenf

© Vstup VGA

© Vstup DVI-D (k dispozici pro vybrané
modely)

@ Zimek proti krédeZi Kensington

Pripojeni k pocitaci

1. Pevné pripojte napdjeci kabel k zadnf strané
monitoru.

2. Vypnéte pocita¢ a odpojte jeho napdjeci
kabel.

3. Pripojte signdlovy kabel monitoru do video
konektoru na zadnf strané pocitace.

4. Zapojte napdjeci kabel pocitace a monitoru
do nejblizsi zdsuvky.

5. Zapnéte pocita¢ a monitor: Jestlize se

na monitoru objevi obraz, instalace je
dokoncena.

‘ PHILIPS ’
5 5

2.2 Ovladani monitoru

(1] Popis vyrobku z ¢elniho pohledu

N

00000

Model 200V4Q:

(5)
AU|T0/V E?]/A /0/4\ E)fOK (ll)
(7] (6] o © (2] o
o o Slouzi k ZAPNUTI a VYPNUTI
napajeni monitoru.
Slouzi ke vstupu do nabidky
O /0K|0sD.

Potvrzeni nastaveni OSD.

< Slouzi k ndvratu na predchozf
drovert OSD.

O-  |Nastaveni Grovné jasu.

A 'V [Slouzi k Upravdm nabidky OSD.

FOfl | Zména formatu zobrazen.

© 606000 0

AUTO |Automatické nastaveni monitoru.




2] Popis zobrazeni funkci na obrazovce

Co je nabidka na obrazovce (OSD)?

Funkci nabidky obrazovky (On-Screen Display,
OSD) jsou vybaveny viechny monitory

LCD Philips. Umozriuje koncovému uzivateli
upravovat vlastnosti obrazovky nebo vybirat
funkce monitoru pffimo prostrednictvim
zobrazeného okna s pokyny. Nize je uveden
priklad prijemného rozhrani obrazovky:

Model 200V4Q:

Zakladni a jednoduché pokyny k ovladacim
tlacitkdm

Ve vyse uvedené nabidce obrazovky OSD
muzete stisknutim tlacitek ¥ A na piednim
rdmecku monitoru pohybovat kurzorem a
stisknutim OK potvrdit vybér nebo zménu.

Nabidka OSD

NiZe je uveden celkovy pohled na strukturu
OSD. Tento prehled mlzete vyuzit, budete-li
chtit pozdéji prozkoumat riiznd nastavent.

Main menu

Input

Picture

Color

Language

OSD Settings

Setup

Sub menu

VGA

DVI

Picture Format —  Wide Screen, 4:3
Brightness — 0~100

Contrast — 0~100

SmartResponse — Off, Fast, Faster, Fastest

available for selective models

SmartContrast —— On, Off
Pixel Orbiting —— On, Off
Gamma — (1.8,2.0,2.2,2.4,2.6)
Color Temperature — 6500K, 9300K
sRGB
User Define Red: 0~100
Green: 0~100
Blue: 0~100

English, Deutsch, Espafiol, EMnvikf, Francais, Italiano,
Maryar, Nederlands, Portugués, Portugués do Brazil,
Polski , Pycckuit, Svenska, Suomi, Tiirkge, Cestina,

Ykpaikcoka, B, ERERL, B AGE T ol

Horizontal — 0~100

Vertical — 0~100
Transparency — Off,1,2,3,4
OSD Time Out — 55, 10s, 20s, 30s, 60s
Auto

H. Position — 0~100
V. Position — 0~100
Phase — 0~100
Clock — 0~100
Resolution Notification — On, Off
Reset — Yes, No

Information



El Poznamka k rozligeni 2.3 Odpojte stojanek podstavce a

Tento monitor je urcen pro optimdini vykon pr podstavec

nativnim rozliseni 1920x1080 pri 60 Hz. Kdyz je

monitor zapnut pfi jiném rozligenf, na obrazovce El Demontiz stojanku podstavce

se zobrazf vystraha: Pro optimaini vysledek Nez zacnete demontovat podstavec monitoru,

pouZijte rozliseni 1920x1080 pii 60 Hz. postupujte podle pokyni nize, aby se zabranilo

Zobrazovani vystrahy na nativni rozligenf Ize jakémukoli moznému poskozeni nebo zranént.

vypnout v &asti Setup (Nastaveni) v nabidce 1. Umistéte monitor obrazovkou dold na

OSD. mékky podklad, aby nedoslo k poskrabanf
obrazovky.

a Fyzické funkce
Naklon

2. Stisknéte zajistovaci svorky a oddélte
stojdnek podstavce od sloupku podstavce.

3. Pro odpojen( sloupku podstavce stisknéte
uvoliiovacf tlacitko.




© Poznimka

Tento monitor je kompatibilni's 1T00mm x
100mm montdznim rozhranim kompatibilnim
se standardem VESA.

100mm

100mm




3. Optimalizace Obrazu

3.1 SmartContrast

E Cojeto?

Jedinecnd technologie, kterd dynamicky analyzuje
zobrazeny obsah a automaticky optimalizuje
kontrastn pomér monitoru LCD pro maximdlni
vizudlni Cistotu a pozitek ze sledovani. Zvysuje
podsvicen( pro jasnéjsi, ostrejsi a jasnéjsi obraz
nebo snizuje podsviceni pro jasné zobrazenf
obrazu s tmavym pozadim.

E1 Proé to potrebuii?

Zadéte nejvyf vizudlni gistotu a pohodli
sledovan( jakéhokoli typu obsahu. SmartContrast
dynamicky f{di kontrast a upravuje podsvicenf
pro jasné, ostré a jasné zobrazeni her a videa
nebo pro zobrazenf jasného, citelného textu
pro kancelarskou praci. Omezenim spotreby
monitoru Setrfte ndklady a prodluzujete zZivot
vaseho monitoru.

E Jak to funguje?

Po aktivaci bude funkce SmartContrast v
redlném Case analyzovat zobrazeny obsah a
upravovat barvy a ridit intenzitu podsviceni. Tato
funkce bude dynamicky vylepSovat kontrast pro
skvély zazitek pri prohlizeni fotografil nebo hranf
her.

3.2 Philips SmartControl Lite

Novy software SmartControl Lite od
spolecnosti Philips umozriuje ovlddat monitor
prostrednictvim snadno pouzitelného grafického
rozhranf na obrazovce. Slozita nastaven( jsou
minulosti, protoze tento uzivatelsky prijemny
software vds provede jemnym vyladénim
rozlisent, kalibraci barev, nastavenim frekvence/
faze, nastavenim bilého bodu RGB atd.

Tento software zaloZeny na pritazlivych
animovanych ikondch kompatibilni se systémem
Windows , ktery je vybaven nejnovejsi
technologil v jddrovém algoritmu pro rychlé

zpracovan( a odezvu, je pripraven rozsitit vasi
zkuenost s monitory Philips!

Kl Instalace

Postupujte podle pokynd a dokoncete
instalaci.

MdZete spustit po dokonceni instalace.
Chcete-li spustit pozdéji, mizete klepnout
na zastupce na pracovni plose nebo na
panel nastrojd.

Monitor driver and software installation

Monitor driver
System requirements:

+ PC running Windows 7/8.1, Vista, XP.
+ Find your dri

> Go to www.philip
Philips SmartControl
System support and requirements:

1. System support Windows 7/8/8.1, Vista, XP.
2. Language support English, German, Spanish, French, Italian, Russian, Portuguese, Simplified Chinese
3. Philips Monitor Plug and Play support

4

»Go to www.portrait.com/diune/phlenu/index o download the latest version of SmartControl software.

Quit B: Next

Prvni spusténi —Wizard (Privodce)

Pri prvnim spusténi po instalaci prejde
SmartControl Lite automaticky na Wizard
(PrAvodce).

Tento prdvodce vds provede podrobnym
nastavenim vykonu monitoru.

Privodce mlzete rovné&z spustit pozdgji z
nabidky Plug-in (Zasuvny modul).

Dalsi moznosti mlzete nastavit bez
pravodce prostrednictvim podokna
Standard (Standardnf).



@ smartControl

SmartControl Lite

-

Adiust Audio
\g Aulo Pivol
-

Color s
o) L
\g 2

Options proe

Help

MuFi Mantors

2- Phips 22581 (C530715000001) ()X

PHILIPS

wizard

Start Weard

E1 Spusténi s podoknem Standard

(Standardni):

Nabidka Adjust (Nastaveni):
Nabidka Adjust (Nastaveni) umozriuje

upravit Brightness (Jas), Contrast (Kontrast),

Focus (Ohnisko), Position (Poloha) a

Resolution (Rozlisent).

MUlzete postupovat podle pokyni a provést

nastavenf.

Cancel (Storno) vyzivéd uzivatele, chcete-li

ukoncit instalaci.
8 smartcontrol

SmartControl Lite

Lip
Brghtness

= 2

Color AR

%

Focus

3

Postion

w
&

2 - Phiips 22581 (€530715000001) |2\ X,
PHILIPS

Brightness

Improperly acjusted Brightness vl result i a loss of
detal i darker image areas. Adjust the Brightness for
the best possble picture qualty
2. Rase the Brightness to the desred level,
3. AQst the Brightness as needed to acheve
an eaqual eparation of the srines.

Brightness 100

Undo Reset

W smartcontol

SmartControl Lite

Adiust

Brightness

0

\g Contrast
olor ~R
AR
. Foaus
Ve
\g Postion
Optons
ii Resolution

Help

' smartControl

SmartControl Lite

Adjust
Brightness
Contast

Color A~
=
“Focus’

Options &

Resolution

Help

8 smartControl

SmartControl Lite

]

Adjust
Brghtness
\g Contrast
Coor 2
A
" Focus
AN
@ Postion
Options %
i\ Resolution

Help

2 - Philps 22581 (C530715000001) [F](X
PHILIPS

Contrast
Adjust the Contrast (use the sider) to keep detais i
lighter image areas.
1. Rase the Contrast unti the numbers 1and 2
are no visble.
the Contrast to make the

nd 3 reappear. 1he numoer 1
chould remain harely vichle.

Contrast. 50

Undo Reset.

2 - Philps 22581 (C530715000001) {F}(X)
PHILIPS

Focus

Your diplay's timing needs to be synchronized with
the video signal.

1. Choose Auto Setup.

2. Fthe vertical bands are stil visble, you'l need

£ adjust the Pitch.

Piteh: Try to make the
Phase: Adiust to the b
movement on the screen.

I bands disappear.
test setting to mnmze

Pitch 50
- &
Phase 7
- &

2 - Phips 22581 (C530715000001) {Z]\X
PHILIPS

Position

the image or

Use the Position bu enter n
this £0ol, you can postion the image

your diplay. Usi
own, left, or rig

1 he Up/Down buttons to center the image

.

g, e Left/Kight buttons to center the mage
harzantaly.

Undo Reset




' smartControl

SmartControl Lite

&

Adiust )
Biightness
\g Contrast
Cobor -
A
Focus
\? Poston
Optons %
:! Resoliton
Help

Nabidka Color (Barva):

2 - Phiips 22581 (CS30715000001)

PHILIPS

Resolution

You are currently 3t 3 Preferred resolution. For your
disply to show crisp, clear text, colors, and mages,
your display should be set to fs Preferred resolution.
F your display s at a Non-Preferred resolution, cick
on the Prafarrad button to changa your resolstion to
Preferred,

T~ Cnable Resolution Noter

Picture Format
I~ 43 3pect oo

Preferred

M ——

* Nabidka Color (Barva) umozriuje upravit
RGB, Black Level (Uroveri cerné), White

Point (Bily bod), Color Calibration (Kalibrace

barev).

*  Mulzete postupovat podle pokynd a provést

nastavenf.

* V nasledujici tabulce vyhledejte polozku
podnabidky na zdkladé vaseho vstupu.
» Priklad pro Color Calibration (Kalibrace

barev)
" @ smartcontrol

SmartControl Lite

&

Adijust RGR
Color anmnt
7 S Display Gamma

-yl

Options Gaibration

“

2 - Phiips 22581 (C530715000001) {F}(X)

PHILIPS

Black Level
Improperly acjusted Black Level wil resuft n 3 loss of
delet it darker iniaye erees. Adust Ure Black Level for
the best possble picture qualey.
1. Adjust the biack level of the Red, Green, and
BUue using the sler bars.

Red 50

o o J

Graen 50

o O &

sue 50

o 4 &
Undo Reset

W smartcontol

SmartControl Lite

]

Adiust R68
\5 Back Level
Golor’ White Pont.
Disley Gamma
'
Optons Calbration

8 smartconrol

SmartControl Lite

w

Adiust RGE
Cobr Wt ot
5 e
Display Gamma
-l
Options Calbration
Hep
W smartcontol

SmartControl Lite

n

Adiust 4
= Black Level
Color Whete Pont.
\g wf‘?
Options Calbration
Help

2 - Philps 22581 (C530715000001) [Z](X
PHILIPS

White Point

‘White Point is the pont 2t which equal combinations
of red, green, and blue light at full ntensty create
white. This effects the overal color qualty. For the
most accurate colors cick the Reset button then
select the Whie Point.
1. Please select the White PONt vaie for the best
passhis color qualty.

White Point 6500€

Undo Reset.

2 Phips 22581 (CS30715000001) (2%
PHILIPS

Display Gamma

Gamima s a component of the pul brghtness n a
display. A lower Gamra vakue produces brights

and a hioher Garmima valve produces darker pixeks.
defauk value for Gamm & 2.2.

T adiist Gamma, SmartTmage mict ha sat fa OFF.
Cick the Smartimage Off button before adiusting
Gamima,

1. Use the sider to select the desred Gamm.

Display Gamma

Er

Smartimage OFf

undo Reser

2 -phips 22581 (cs30715000001) (E}X)

PHILIPS

Calibration

Your display needs to be propery calibrated in order
for  to produce the widest range of colrs accurately.
Calibration should ahays take place 3s the st tuning
step i the process. Remember to recalbrate any time
You make individual agjustments to image qua
whentever you move your dsplay Lo & niew hocatio

- Make 3l other necessary adiustments o image

qualny frst.

Press Show Me to leam how to use the
aalibration took.
Finaly, press Start to hegin the calibration
process.

F Cnable color calbration
Color software desgned i colaboration with Joseph

Holmes.
Protected by U.S. Patent No. 6,686,953

Show Ma start

Quick view



1. Tlagitko ,,Show Me" (Predvést) spustf
vyukovy program pro kalibraci barev.

2. Start (Spustit) — zahdji sekvenci kalibrace
barev o 6. krocich.

3. QuickView (Rychlé zobrazeni) nacte
zobrazeni pred/po.

4. Chcete-li se vrdtit na hlavni stranku Color
(Barva), klepnéte na tlacitko Cancel
(Storno).

5. Enable color calibration (Povolit kalibraci
barev) — ve vychozi konfiguraci je zapnuto.
Pokud tato polozka nenf zaskrtnuta, kalibraci
barev nelze provést a tlacitka rychlé
zobrazenf nejsou k dispozici.

6. Na kalibracni obrazovce musf byt zobrazeny
informace o patentech.

Calibration Screen (Obrazovka kalibrace)
prvni barvy:

* Tlacftko Previous (Predchozi) je
deaktivovdno az na obrazovku druhé barvy.

*  Tlacitko Next (Dalsi) slouzi k prechodu na
nasleduijici cil (6 cild).

»  Tlacitko Konecny slouzi k prechodu na File
> Presets (Soubor > podokno Predvolby).

*  Tlacitko Cancel (Storno) slouzi k ukoncenf
uzivatelského rozhranf a k ndvratu na
strdnku zdsuvnych moduld plug-in.

Options>Preferences (Moznosti>Predvolby) —
Tato moznost bude aktivni pouze po vybéru
polozky Preferences (Predvolby) v rozeviraci
nabidce Options (MozZnosti). Na nepodporova-
ném zobrazovacim zarizeni' s podporou DDC/
Cl jsou k dispozici pouze karty Help (Ndpovéda)
a Options (MoZnosti).
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SmartControl Lite PHILIPS

Preferences

Zobrazi nastaven( aktudnich predvoleb.
Zaskrtnuté tlacitko aktivuje funkci.
Zaskrtdvaci policko je prepinac.

PoloZka Enable Context Menu (Povolit
mistni nabidku) na pracovni plose je ve
vychozi konfiguraci zaskrtnutd (Zapnuto).
Po aktivaci polozky Enable Context

Menu (Povolit mistni nabidku) se zobrazi
vybéry SmartControl Premium pro funkce
Select Preset (Vybrat predvolbu) a Tune
Display (Ladéni zobrazeni) na pracovni
plose klepnutim pravym tlacitkem mysi na
mistni nabfdku. Volbou moZznosti Disabled
(Deaktivovdno) bude polozka SmartControl
Premium odstranéna z mistni nabidky
pravym tlacitkem mysi.

PoloZka Enable Task Tray (Povolit ikonu na
hlavnim panelu) je ve vychozi konfiguraci
zaskrtnutd (Zapnuto). Po aktivaci polozky
Povolit mistnf nabidku se zobrazi nabidka
SmartControl Lite na hlavnim panelu.
Klepnutim pravym tlacitkem mysi na ikonu
na hlavnim panelu se zobrazi moznosti
nabidky Help (Ndpovéda), Technical
Support (Odborna pomoc), Check for
Update (Vyhledat aktualizace), About

(O aplikaci) a Exit (Konec). Kdyz je
deaktivovdna polozka Enable task tray menu
(Povolit nabidku na hlavnim panelu), ikona
na hlavnim panelu zobrazuje pouze moznost
EXIT (KONEC).



* PoloZka Run at Startup (Spustit pri startu) je
ve vychoz( konfiguraci zaskrtnutd (Zapnuto).
Kdyz je tato polozka deaktivovdna, funkce
SmartControl Lite se nespustf pri startu
nebo nebude na hlavnim panelu. Funkci
SmartControl Lite Ize spustit pouze
prostrednictvim zdstupce na pracovni
plose nebo prostrednictvim souboru
programu. Kdyz toto poli¢ko nenf zaskrtnuté
(Deaktivovdno), zddnd priedvolba nastavend
pro spusténi pfi startu nebude nactena.

* Enable transparency mode (Aktivovat rezim
prahlednosti) (Windows 7/8.1, Vista, XP).
Vychozi nastaveni je O % neprdhlednost.

Options>Input (Moznosti>Vstup) — Tato
moznost bude aktivni pouze po vybéru
polozky Input (Vstup) v rozeviraci nabidce
Options (Moznosti). Na nepodporovaném
zobrazovacim zafizeni' s podporou DDC/CI
jsou k dispozici pouze karty Help (Napovéda)
a Options (Moznosti). Zddné dal3f karty funkce
SmartControl Lite nejsou k dispozici.

@ smartControl

2 - Philps 22581 (CS30715000001) {Z](X

PHILIPS

SmartControl Lite

Adjust

Color

Options Presets

N ul

\g e

Help

Analog In Digical In

» Zobrazi podokno s pokyny Source (Zdroj)
a nastaven( aktudiniho zdroje vstupu.

* U zobrazovacich zarizen( s jednim vstupem
nenf toto podokno zobrazeno.
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Options>Audio (Moznosti>Zvuk) — Tato
moznost bude aktivni pouze po vybéru polozky
Audio (Hlasitost) v rozeviraci nabidce Options
(Moznosti).

Na nepodporovaném zobrazovacim zarizenf s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).

'8 SmartControl 2 - Philps 22581 (CS30715000001) (2)(X)

SmartControl Lite PHILIPS

ated loudspeakers by

akers by checking the

&

Adiust yy

e

Color

PN B
wiard
- g
Optons Presets
~ o
\g Hutibontars
=

Volume 100
Help =

Undo

Help>User Manual (Napovéda>Uzivatelska
prirucka) —Tato moznost bude aktivni pouze
po vybéru polozky User Manual (Uzivatelskd
prirucka) v rozeviraci nabidce Help (Ndpovéda).
Na nepodporovaném zobrazovacim zarizeni s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).

'8 SmartControl 2 - Philps 22581 (C530715000001) (2)\X

SmartControl Lite PHILIPS

User Manual

Adjust

User Manual

-
[ ®
Color n

. b A

)
\@ -
Options

X3

Verson

User Manual Tech. Support



Help>Version (Napovéda>Verze) —Tato
moznost bude aktivni pouze po vybéru
polozky Version (Verze) v rozeviraci nabidce
Help (Ndpovéda). Na nepodporovaném
zobrazovacim zarizen( s podporou DDC/CI
jsou k dispozici pouze karty Help (Ndpovéda) a
Options (MoZznosti).
8 SmartControl

2 - phiins 2251 (CS30715000001) (2] X

SmartControl Lite PHILIPS

Context Sensitive menu (Mistni nabidka)
Context Sensitive Menu (Mistni nabidka) je
ve vychozi konfiguraci Aktivovana. Nabidka
bude zobrazena po zaskrtnuti polozky Enable
Context Menu (Povolit mistni nabidku) v ¢asti
Options > podokno Preferences (Moznosti >

podokno Predvolby).

E SmartControl
Helect Preset L3
Tune Display

Context Menu (Mistni nabidka) obsahuje 3

polozky:

*  SmartControl Lite - po vybéru se zobrazf
obrazovka About (O) aplikaci.

*  Select Preset (Vybrat predvolbu) — nabizf
hierarchickou nabidku uloZenych predvoleb
pro okamzité pouzitl. Aktudlné vybrand
predvolba je oznacena zaskrtnutim. V
rozeviracl nabidce Ize rovnéZ vybrat polozku
Predvolby vyrobce.
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* Tune Display (Ladéni zobrazeni) — otevre
ovlddaci panel SmartControl Lite.

Aktivovana nabidka hlavniho panelu

Nabidku hlavniho panelu lze zobrazit klepnutim
pravym tlacitkem mysi na ikonu SmartControl
Lite na hlavnim panelu. Klepnutim levym
tlacitkem Ize spustit aplikaci.

Help

Technical Support
Check For Update
About

Exik

Hlavni panel obsahuje pét polozek:

* Help (Ndpovéda) — pristup k souboru
s User Manual (uzivatelskou priruckou):
Otevr'e soubor s User Manual (uzivatelskou
priruckou) v okné vychoziho prohlizece.

* Technical Support (Odbornd pomoc) —
zobraz/ stranku odborné pomoci.

*  Check for Update (Vyhledat aktualizace) —
zobrazi Uvodn( stranku PDI a porovnad verzi
uzivatele s nejaktudlnéjsi dostupnou verzi.

* About (O aplikaci) — zobrazi podrobné
referencni informace: verze produktu,
informace o vydanf a ndzev produktu.

*  Exit (Konec) - ukoncf SmartControl Lite

Chcete-li znovu spustit funkci SmartControl Lite,
vyberte polozku SmartControl Lite z nabidky
Program, poklepejte na ikonu na pracovni plose
pocitae nebo restartujte pocital.

SmartControl

PHILIPS

SmartControl
ersion 3.20
chune-standard-R2007-01-04-1151-23
Copyright 1883-2007 Portrait Displays, Inc
Patents Pending




Deaktivovana nabidka hlavniho panelu

Kdyz je hlavni panel deaktivovan ve slozce
Preference (Predvolby), je k dispozici pouze
¢ast EXIT (KONEC). Chcete-li funkci
SmartControl Lite zcela odstranit z hlavniho
panelu, deaktivujte polozku Run at Startup
(Spustit pri startu) v ¢asti Options>Preferences
(Moznosti>Predvolby).

& Pozndmka

Veskeré ilustrace v této casti jsou pouze
orientacni.Verze softwaru SmartControl se
muUze zménit bez predchoziho upozornén.
Vzdy navstivte oficidini webové stranky Portrait
na adrese www.portrait.com/dtune/phl/enu/
index a stdhnéte si nejnovéjsi verzi softwaru
SmartControl.
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4. Technické udaje

Obraz/displej

Moznosti pripojeni
Vstup signdlu

Typ panelu LCD MVA LCD

Podsvicenf LED

Velikost panelu 19.53" S (49,6 cm)
Pomér stran 16:9

Rozte¢ obrazovych bodu 0,23X0,22mm

Jas 250 cd/m?
SmartContrast 10,000,000:1

Kontrastni pomér (typ.) 3000:1

Doba odezvy (typickd) 20ms(200V4QSB)
SmartResponse 8ms(GtG)(200V4QSBR)
Optimalni rozliseni 1920x1080@60Hz
Zorny Uhel 178° (H) /178° (V) @ C/R> 10
Barevnost displeje 16,/M

Vertikdlni obnovovacf frekvence | 56Hz - 76Hz
HorizontdInf frekvence 30kHz - 83kHz

sRGB ANO

DVI-D (digitdlni), VGA (analogovy)

Vstupnf signal
Usnadnéni

Usnadnénf pro uzivatele

Oddélend synchronizace, synchronizace podle zelené

AaUTO/VY  [O0/A 0-/4 /0K )

Jazyky nabidky OSD

English, Deutsch, Espafiol, ENMAnvikn, Francais, Italiano, Maryar,
Nederlands, Portugués, Portugués Brazil, Polski, Pycckui,
Svenska, Suomi, Ttrkge, Cestina, VipaiHcora, fijfAH 32,
ML, HAGE, 8t=0

Dal3i usnadnénf

Zamek Kensington

Kompatibilita s technologif
Plug & Play

DDC/CI, sRGB, Windows 7/ Windows 8.1/Vista/XP, Mac OSX,
Linux

Podstavec
Néklon -5/+20
200V4QSB:
Zapnuto 229W (typ.), 23,47W (max.)
Spanek (Pohotovost) 0,5W
Vypnuto 0,5W
Indikator napdjenf Zapnuto: Bild, Pohotovostni rezim/rezim spanku: Bila (blikd)
Napdjen( Vypaleni, 100-240VAC, 50-60Hz
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200V4QSBR:

Zapnuto 2321W (typ.), 24,17W (max.)

Spanek (Pohotovost) 0,5W

Vypnuto 0,5W

Indikdtor napdjenf Zapnuto: Bild, Pohotovostni rezim/rezim spanku: Bild (blikd)
Napdjenf Vypdleni, 100-240VAC, 50-60Hz

Rozméry

Vyrobek s podstavce (5xVxH)
Vyrobek bez podstavce (SxVxH)
Hmotnost

479 x 369 x 201 mm
479 x 299 x 48 mm

Vyrobek s podstavcem 2,72kg

Vyrobek bez podstavce 2,3%g

Provozni podminky

Teplotni rozsah (provoz) 0°Caz 40 °C
Teplotni rozsah (mimo provoz) -20°C a7 60°C
Relativni vihkost 20% az 80%

MTBF 30 000 hod

ROHS ANO

EPEAT (Predpisy se mohou v Silver (www.epeat.net)
jednotlivych zemich lisit)

Balen( 100% recyklovatelny
Specifické Vldtky Kryt 100% bez PVC BFR

Energy Star(Predpisy se mohou v | ANO
jednotlivych zemich lisit)
Shoda a normy
Prohldseni o shodé CE Mark, FCC Class B, TCO Certified, ETL, 1SO9241-
307,EPA, UKRAINIAN,CEL, China RoHS, CCC, CECP, PSB,
WEEE, CU,C-tick

Barva Cemd
Povrchovd Uprava Leskd/Textura
© Poznamka

RN

. Certifikdt EPEAT Gold nebo Silver je platny pouze tam, kde spolecnost Philips zaregistruje produkt.
Informace o stavu registrace ve vasi zemi viz www.epeat.net.

Tyto Udaje se mohou zménit bez predchoziho ozndment. Stéhnéte si nejnovejsi verzi letdku z webu
www.philips.com/support.
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4.1 Rezimy rozliseni a predvoleb

El Maximalni rozliseni
1920 x 1080 pri 60 Hz (analogovy vstup)
1920 x 1080 pfi 60 Hz (digitalnf vstup)

E1 Doporuéené rozliseni
1920 x 1080 pri 60 Hz (digitdIni vstup)

Vodorovna Rozliseni Svisla
frekvence frekvence
(kHz) (Hz)
31,47 720 x 400 70,09
31,47 640 x 480 59,94
35,00 640 x 480 66,67
37,86 640 x 480 72,81
37,50 640 x 480 75,00
37,88 800 x 600 60,32
46,88 800 x 600 75,00
48,36 1024 x 768 60,00
60,02 1024 x 768 75,03
44,77 1280 x 720 59,86
63,98 1280 x 1024 60,02
79,98 1280 x 1024 75,03
55,94 1440 x 900 59,89
70,64 1440 x 900 7498
65,29 1680 x 1050 59,95
67,50 1920 x 1080 60,00
& Poznimka

Upozormiujeme vds, Ze tento monitor funguje
nejlépe pri nativnim rozliseni 1920 x 1080 pri
60 Hz. Pro dosazeni optimaln( kvality zobrazenf
dodrzujte toto doporucené rozlisent.
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5. Rizeni spotieby

Pokud je v daném pocitaci nainstalovdn software
nebo videokarta vyhovujici normé DPM
organizace VESA, monitor dokdze automaticky
snizit svou spotrebu energie, neni-li pouzivan.
Pokud pocitac rozpozna vstup z kldvesnice,

mysi nebo jiného vstupniho zarizeni, monitor se
automaticky ,,probud*. Nasledujici tabulka uvadf
spotrebu energie a signalizaci této funkce pro

automatickou Usporu energie:

200V4QSB:
Definice rizenf spotreby
ReZim VESA| Video [ H-synch. | V-synch. | Spoteba energie | Barva indikétoru LED
Aktivni | ZAP. | Ano Ano 229W (typ.) Bila
Spanek VYP. Ne Ne 0.5W (typ.) Bl (blikd)
Vypnuto | VYP. - - 05W (typ.) VYP.
200V4QSBR:

Definice rizen( spotreby

ReZim VESA| Video | H-synch. [ V-synch. | Spotieba energie | Barva indikdtoru LED
Aktivni | ZAP. | Ano | Ano | 2321W (typ) Bi&
Spanek [ VYP. Ne Ne 05W (typ.) Bild (blikd)
Vypnuto | VYP. - - 0.5W (typ.) VYP.

Ndsledujic konfigurace se pouziva pri mérenf

energetické spotreby tohoto monitoru.

* Nativni rozliseni: 1920%1080

*  Kontrast: 50%

* Jas: 250 nitd

* Barevnd teplota: 6500 K s pIné bilym
vzorkem

& Poznimka
Tyto Udaje se mohou zménit bez predchoziho
ozndment.
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6. Informace o regulaci
(Predpisy se mohou v jednotlivych zemich lisit)

Congratulations!

This product is TCO Certified - for Sustainable
[T

TCO Certified is an international
1,!:_9 third party sustainability certificati-

on for IT products. TCO Certified.
ensures that the manufacture, use and recycling
of IT products reflect environmental, social and
economic responsibility. Every TCO Certified
product model is verified by an accredited inde-
pendent test laboratory.

This product has been verified to meet all the
criteria in TCO Certified, including:

* Corporate Social Responsibility
Socially responsible production - working
conditions and labor law in manufacturing
country

* Energy Efficiency
Energy efficiency of product and power
supply. Energy Star compliant, where
applicable

* Environmental Management System
Manufacturer must be certified according
to either ISO 14001 or EMAS

*  Minimization of Hazardous Substances
Limits on cadmium, mercury, lead
& hexavalent chromium including
requirements for mercury-free products,
halogenated substances and hazardous
flame retardants

*  Design for Recycling
Coding of plastics for easy recycling. Limit
on the number of different plastics used.

¢ Product Lifetime, Product Take Back
Minimum one-year product warranty.
Minimum three-year availability of spare
parts. Product takeback

* Packaging
Limits on hazardous substances in product
packaging. Packaging prepared for recycling

20

*  Ergonomic, User-centered design
Visual ergonomics in products with a
display. Adjustability for user comfort
(displays, headsets) Acoustic performance
— protection against sound spikes
(headsets) and fan noise (projectors,
computers) Ergonomically designed
keyboard (notebooks)

» Electrical Safety, minimal electro-magnetic
Emissions Third Party Testing
All certified product models have been
tested in an independent, accredited
laboratory.

A detailed criteria set is available for download
at www.tcodevelopment.com, where you can
also find a searchable database of all TCO
Certified IT products.

TCO Development, the organization behind
TCO Certified, has been an international
driver in the field of Sustainable [T for 20 years.
Criteria in TCO Certified are developed in
collaboration with scientists, experts, users

and manufacturers. Organizations around the
world rely on TCO Certified as a tool to help
them reach their sustainable IT goals. We are
owned by TCO, a non-profit organization
representing office workers. TCO Development
is headquartered in Stockholm, Sweden, with
regional presence in North America and Asia.

For displays with glossy bezels, the user should
consider the placement of the display as the
bezel may cause disturbing reflections from
surrounding light and bright surfaces.

For more information, please visit
www.tcodevelopment.com

[}

CERTIFIED

Technology for you and the planet

(Only for selective models)

Lead-free Product

s Leod Free!

Lead free display promotes
environmentally sound recovery and
disposal of waste from electrical and




electronic equipment. Toxic substances like
Lead has been eliminated and compliance with
European community’s stringent RoHs directive
mandating restrictions on hazardous substances
in electrical and electronic equipment have been
adhered to in order to make Philips monitors
safe to use throughout its life cycle.

EPEAT

(Wwww.epeat.net)

@  The EPEAT (Electronic
Qéb Product Environmental
22 Assessment Tool) program
evaluates computer desktops,
laptops, and monitors based on 51 environ-
mental criteria developed through an extensive
stakeholder consensus process supported by
US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and select
desktop computers, notebooks and monitors
based on their environmental attributes. EPEAT
also provides a clear and consistent set of per-
formance criteria for the design of products, and
provides an opportunity for manufacturers to
secure market recognition for efforts to reduce
the environmental impact of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specificati-
ons, means that these products will consume
less energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

»  EN60950-1:2006+A11:2009+A1:20
10+A12:2011 (Safety requirement of
Information Technology Equipment).

»  EN55022:2010 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:2010 (Immunity requirement of
Information Technology Equipment).

+  EN61000-3-2:2006 +A1:2009+A2:2009
(Limits for Harmonic Current Emission).

»  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

* 2006/95/EC (Low Voltage Directive).

» 2004/108/EC (EMC Directive).

*  2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

* 1S09241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

*  GS EK1-2000:2011 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

* MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

*  TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product

meets the ENERGY STAR®
guidelines for energy efficiency.
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& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turing the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

*  Consult the dealer or an experienced
radio/TV technician for help.

22

@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

S

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following
two conditions: (1) this device may not cause
harmful interference, and (2) this device must
accept any interference received, including
interference that may cause undesired
operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de l'article
15 Des regles de la FCC. Ces limites sont
congues de facon a fourir une protection
raisonnable contre les interférences nuisibles
dans le cadre d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.


www.energystar.gov

Cependant, rien ne peut garantir |'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

* Brancher '€quipement sur un autre circuit
que celui utilisé par le récepteur

e Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a l'utilisateur 'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic Only)

This dswice belongs to category B devices as described in EN 55022, unless it is specifi-
cally stated that it is a Class A devics on the speciication labal. The following appiies to
devices in Class A of EN 55022 (radius of protection up 1o 30 meters). The ussr of the
devics iz obliged to taks all staps necessary to remove sources of intarfarencs 1o tels-
communication or sther devicss.

Pokud neni na typovém Bithu pottate uvedeno, 26 spadé dodo tidy A podie EN 55022,
spada automaticky do thidy B podle EN 55022, Pro zafizen! zafazend do tFidy A (chranné
pésma 30m) podie EN 55022 platl nésleduficl. Dojde-li k rullan! telskamunikataich nebo
Finjich zafizeni je uZivatal povinnen provést takovd opatfgn, aby nseni odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so
on) should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/
T-42107 and PN-89/E-06251.

Wymagama Polskugo Centrum Badan i Certyfi) kaqr

Pozostale instrukcje begpieczensiwa

* Nie maleiy uiywad wiyceek adapterowych lub
Je a1

wad kodka abwodu o
v wiyi preediuzace 3

g 5 wiyceki.
lowe

+ Spsem crany . P i, chwilowymi werostami bub spad-

bz wakid n niego.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS,

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILG/ANGELIGE.

Paikka/llmankierto

VAROITUS:

SIOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
HAZBERERIIEE |
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Roéntgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerdtes befindet sich
ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Stérstrahlern nach Anlage
a5 Abs. 4 der Réntgenverordnung erfiilit
sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildrohre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhdhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.

Restriction on Hazardous Substances
statement (India)

This product complies with the “India E-waste
Rule 2011"" and prohibits use of lead, mercury,
hexavalent chromium, polybrominated biphenyls
or polybrominated diphenyl ethers in concent-
rations exceeding 0.1 weight % and 0.01 weight
% for cadmium, except for the exemptions set
in Schedule 2 of the Rule.



E-Waste Declaration for India

This symbol on the product or on its pac-
kaging indicates that this product must not be
disposed of with your other household waste.
Instead it is your responsibility to dispose of
your waste equipment by handing it over to a
designated collection point for the recycling of
waste electrical and electronic equipment . The
separate collection and recycling of your waste
equipment at the time of disposal will help to
conserve natural resources and ensure that it

is recycled in a manner that protects human
health and the environ-ment. For more informa-
tion about where you can drop off your waste
equipment for recycling in India please visit the
below web link.

http://www.india.philips.com/about/sustainability/

recycling/index.page
Information for U.K. only

WARNING - THIS APPLIANCE MUST BE
EARTHED.

Important:

This apparatus is supplied with an approved
moulded 13A plug. To change a fuse in this
type of plug proceed as follows:

1. Remove fuse cover and fuse.

2. Fit new fuse which should be a BS 1362
5AAS.TA. or BSI approved type.

3. Retit the fuse cover

If the fitted plug is not suitable for your socket

outlets, it should be cut off and an appropriate

3-pin plug fitted in its place.

If the mains plug contains a fuse, this should

have a value of 5A. If a plug without a fuse is
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used, the fuse at the distribution board should
not be greater than 5A.

NOTE: The severed plug must be destroyed to
avoid a possible shock hazard should it
be inserted into a 13A socket elsewhe-
re.

How to connect a plug

The wires in the mains lead are coloured in
accordance with the following code:

BLUE -“NEUTRAL"("N")
BROWN -“LIVE"("L")
GREEN&YELLOW -"EARTH"(“E")

1. The GREEN&YELLOW wire must be
connected to the terminal in the plug
which is marked with the letter "E" or by
the Earth symbol or coloured GREEN or
GREEN&YELLOW.

2. The BLUE wire must be connected to the
terminal which is marked with the letter
"N" or coloured BLACK.

3. The BROWN wire must be connected
to the terminal which is marked with the
letter "L" or coloured RED.

Before replacing the plug cover, make certain

that the cord grip is clamped over the sheath of

the lead - not simply over the three wires.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products produced and sold for Chi-
na market have to meet China RoHS request.
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EU Energy Label

The European Energy Label informs you on the
energy efficiency class of this product. The gree-
ner the energy efficiency class of this product is
the lower the energy it consumes.

On the label, you can find the energy efficiency
class, the average power consumption of this
product in use and the average energy con-
sumption for 1 year.

SNote
The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.



7. Péce o zakazniky a zaruka

7.1 Postup pri vadnych pixelech
plochého panelu spolecnosti
Philips

Spolecnost Philips se snazi doddvat vyrobky
vyrobnich postup( vyroby v tomto odvétvi a
prosazuje prisnou kontrolu kvality. Defektim
obrazovych bodd nebo dil¢ich obrazovych
bodl u paneld TFT LCD, které se pouZzivajf
pro ploché monitory, se nicméné nékdy nedd
zabranit. Zadny vyrobce nemuize zarudit, ze
vSechny panely budou bez defektd obrazovych
bodd, ale spole¢nost Philips zarucuje, ze kazdy
monitor s neprijatelinym poctem defektl bude
v rdmci zdruky opraven nebo vymeénén.Tento
text vysvétluje jednotlivé druhy defektl na
pixelech a urcuje Unosnou urover chybovosti
pro kazdy druh. Aby bylo mozné uplatnit zarucnf
opravu nebo vyménu, musi pocet defektnich
obrazovych bodd panelu TFT LCD presdhnout
tuto Uroveri Unosnosti. Na monitoru napriklad
nesmf byt vice defektnich dil¢ich obrazovych
bodd nez 0,0004 %. Déle, protoze nékteré typy
kombinaci vad pixell jsou lépe postrehnutelné
nez jiné, stanovuje pro né spolecnost Philips
jesté vetsi ndroky na kvalitu. Tato norma se
dodrzuje celosvétove.

subpixely subpixely subpixely

vy
pixelly

Pixely a subpixely

Pixel, neboli obrazovkovy bod, se skldda ze trf
subpixeld v zakladnich barvéch Cervené, zelené a
modré. Kdyz je mnoho pixeld pohromadeé, tvorf
obraz. Kdyz viechny subpixely ur¢itého pixelu
svitf, jevi se tyto tfi subpixely spole¢né jako
jediny bily pixel. Kdyz jsou viechny tmavé, jevl
se tyto tfi subpixely jako jeden cerny pixel. Dalsf
kombinace rozsvicenych a tmavych subpixell se
jevi jako pixely rdznych barev.
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Druhy pixelovych vad

Vady pixell a subpixeld se na obrazovce
projevuji rznymi zplsoby. Existuji dva druhy
vad pixelu a v rdmci téchto druhd je nékolik
typd subpixelovych vad.

Defekty svétlych bodu

Defekty svétlych bodl se projevuji jako
obrazové body nebo dil¢f obrazové body, které
vzdy sviti nebo jsou 'aktivni'. Svétly bod je dilef
obrazovy bod, ktery vystupuje z obrazovky, kdyz
je na monitoru zobrazena tmava plocha. Existujf

nasledujici typy defektl svétlych bodd:

Jeden Cerveny, zeleny nebo modry subpixel

¢

Dva soundlezicl subpixely:
- lerveny + modry = fialovy
- Cerveny + zeleny = Zluty
- zeleny + modry = svétle modry

Tri soundlezicl rozsvicené subpixely (jeden bily
pixel).



& Pozniamka

Cerveny nebo modry svétly bod musi byt o
vice nez 50 procent jasnéjsi, nez sousedni body;
zeleny svétly bod je o 30 procent jasngjsi, nez
sousedn( body.

Defekty tmavych bodu

Defekty tmavych bodd se projevuji jako
obrazové body nebo dil¢i obrazové body, které
nikdy nesvitf nebo jsou ,,neaktivni. Tmavy bod je
dilei obrazovy bod, ktery vystupuje z obrazovky,
kdyz je na monitoru zobrazena svétld plocha.
Existuji nasledujici typy defektd tmavych bodd:

Vzdalenost pixelovych vad

Protoze vady pixell a subpixell stejného

typu, které se vyskytuji blizko sebe, mohou byt
patrnéjsi, urcuje spole¢nost Philips i tolerance na
vzdalenost vad pixeld.

Tolerance vad pixell

Aby bylo mozné uplatnit opravu nebo vyménu
kvlli defektnim obrazovym boddm v zaru¢nf
dobé, musf panel TFT LCD plochého monitoru
Philips vykazovat defekty obrazovych bodu
nebo dil¢ich obrazovych bod(, které prekracujf
tolerance uvedené v ndsledujicich tabulkdch.

KAZY JASNYCH BODU

PRIJATELNY POCET VAD

1 trvale svitici bod 3
2 sousedni trvale svitici body 1
3 sousednl trvale sviticf body (nebo 1 trvale svitici bily bod) 0
Vzdalenost mezi dvéma kazy jasnych bodi* >15 mm
Celkovy pocet kazl jasnych bodd viech typl 3

KAZY CERNYCH BODU
1 tmavy bod

PRIJATELNY POCET VAD
5 nebo méné

2 sousedni tmavé body

2 nebo méné

3 sousedni tmavé body

0

Vzddlenost mezi dvéma kazy cemych bodi*

>15 mm

Celkovy pocet kazt ¢ernych bodd viech typl

5 nebo méné

KAZy bodl celkem

PRIJATELNY POCET VAD

Celkovy pocet kazl jasnych nebo ¢ernych bodud viech typl

5 nebo méné

& Poznamka

1. 1 nebo 2 sousedni vadné body (1 barva) = 1 vadny bod

2. Tento monitor je kompatibilni se standardem ISO 9241-307. ( ISO 9241-307: Ergonimicky
pozadavek, analyza a metody testovani shody pro elektronickd zobrazovaci zarizen)

3. Norma 1SO9241-307 je naslednikem drivéjsi normy ISO13406, kterd byla zrusena organizaci 1ISO
(International Organisation for Standardisation) ke dni: 2008-11-13




7.2 Péce o zakazniky & zaruka

Podrobné informace o zdruce a pozadavku na dodatecnou podporu platné pro vasi oblast najdete na
webu www.philips.com/support. Rovnéz muizete kontaktovat mistni centrum péce o zdkazniky na nize
uvedenych telefonnich &islech.

Kontaktni informace pro oblast ZAPADNI EVROPY:

Zemé CSP Horka linka Cena Oteviraci doba

Austria RTS +43 0810 000206 €007 Mon to Fri: 9am - 6pm
Belgium Ecare +32 078 250851 €0.06 Mon to Fri: 9am - 6pm
Cyprus Alman 800 92 256 Free of charge | Mon to Fri: 9am - 6pm
Denmark Infocare +45 3525 8761 Local call tariff | Mon to Fri: 9am - 6pm
Finland Infocare +358 09 2290 1908 | Local call tariff [ Mon to Fri: 9am - 6pm
France Mainteq +33 082161 1658 €0.09 Mon to Fri: 9am - 6pm
Germany RTS +49 01803 386 853  |€0.09 Mon to Fri: 9am - 6pm
Greece Alman +30 00800 3122 1223 | Free of charge [ Mon to Fri: 9am - 6pm
Ireland Celestica +353 01 601 1161 Local call tariff [ Mon to Fri: 8am - 5pm
Italy Anovo [taly | +39 840 320 041 €0.08 Mon to Fri: 9am - 6pm
Luxembourg Ecare +352 26 84 30 00 Local call tariff | Mon to Fri: 9am - 6pm
Netherlands Ecare +31 0900 0400 063 €0.10 Mon to Fri: 9am - 6pm
Norway Infocare +47 2270 8250 Local call tariff | Mon to Fri: 9am - 6pm
Poland MSI +48 0223491505 Local call tariff | Mon to Fri: 9am - 6pm
Portugal Mainteq 800 780 902 Free of charge [ Mon to Fri: 8am - 5pm
Spain Mainteq +34 902 888 785 €0.10 Mon to Fri: 9am - 6pm
Sweden Infocare +46 08 632 0016 Local call tariff [ Mon to Fri: 9am - 6pm
Switzerland ANOVO CH [ +41 02 2310 2116 Local call tariff | Mon to Fri: 9am - 6pm
United Kingdom | Celestica +44 0207 949 0069 Local call tariff | Mon to Fri: 8am - S5pm

Kontaktni informace pro Cinu:

Cislo zakaznické péce

4008 800 008

Telefonni stredisko

China PCCW Limited

Kontaktni informace pro SEVERNI AMERIKU:

Telefonni stredisko

Cislo zékaznické péce
(877) 835-1838

USA

Canada

EPl-e-center

EPl-e-center (800) 479-6696

29



Kontaktni informace pro oblast STREDNI A VYCHODNI EVROPY:

Telefonni
stredisko

CSP Cislo zakaznické péce

+37517 217 3386

Belarus NA IBA +375 17 217 3389
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA MR Service Ltd +385 (01) 640 1111
Czech Rep. NA Asupport 420 272 188 300
we o [pemmee
Georgia NA Esabi +995 322 91 34 71
+36 1 814 8080(General)
Hungary NA Profi Service +36 1814 8565(For AOC&Philips
only)
Kazakhstan NA Classic Service llc. | +7 727 3097515
+
Latvia NA ServiceNet LV _331 ;;;Zggzz
Lithuania NA UAB Servicenet Ig;g ;47}0%%08186(()%:EEEBS)
Macedonia NA AMC +389 2 3125097
Moldova NA Comel +37322224035
Romania NA Skin +40 21 2101969
Russia NA CPS +7 (495) 645 6746
Serbia&Montenegro | NA Kim Tec d.o.o. +381 11 20 70 684
Slovakia NA Datalan Service +421 2 49207155
Slovenia NA PC H.and +386 1 530 08 24
the republic of Belarus | NA ServiceBy + 37517 284 0203
Turkey NA Tecpro +90 212 444 4 832
Ukraine NA Topaz +38044 525 64 95
Ukraine NA Comel +380 5627444225

Kontaktni informace pro oblast LATINSKE AMERIKY:

Telefonni stredisko

Brazil

Argentina

Vermont

Cislo zakaznické péce
0800-7254101

0800 3330 856
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Kontaktni informace pro oblast APMEA:

Zemé

Australia

ASP
AGOS NETWORK PTY LTD

Cislo zakaznické péce
1300 360 386

Oteviraci doba
Mon.~Fri. 9:00am-5:30pm

New Zealand

Visual Group Ltd.

0800 657447

Mon.~Fri. 8:30am-5:30pm

Hong Kong:

gy Hd. MacauTel: (853)-0800-987 7 P
. Tel: 1 800 425 6396 .
India REDINGTON INDIA LTD SMS: PHILIPS to 56677 Mon.~Fri. 9:00am-5:30pm
+62-21-4080-9086 (Customer _ . A
ndonesia PT. CORMIC SERVISINDO | Hotline) :43?86-31-;608'30_1 200;
PERKASA +6278888-O1 -9086 (Customer Fri. 08:30-11:30; 13:00-17:30
Hotline)
. Mon.~Fri. 9:00am-5:30pm
Korea Alphascan Displays, Inc 1661-5003 Sat. 9:00am-1:00pm
. . Mon.~Fri. 8:15am-5:00pm
Malaysia R-Logic Sdn Bhd +603 5102 3336 Sat. 8:30am-12:30am
Pakistan TVONICS Pakistan +92-213-6030100 Sun.~Thu. 10:00am-6:00pm
Philips Electronics Singapore B G :
Singapore | Pte Ltd (Philips Consumer Care | (65) 6882 3966 Mon.~Fri. 9:00am-6:00pm
Sat. 9:00am-1:00pm
Center)
Taiwan FETEC.CO 0800-231-099 Mon.~Fri. 09:00 - 18:00
Thailand Ais Computer System Co. | ¢y 934 5498 Mon.~Fri. 8:30am~05:30pm

Ltd.

South Africa

Computer Repair Technologies

011 262 3586

Mon.~Fri. 8:00am~05:00pm

Israel

Eastronics LTD

1-800-567000

Sun.~Thu. 08:00-18:00

+84 8 38248007 Ho Chi Minh

FPT Service Informatic City = ; )

Vietnam Company Ltd. - Ho Chi Minh | +84 5113.562666 Danang City :47?;(') SF;[I 2:88:3:88’ 13:30-
City Branch +84 5113562666 Can tho bt SELS

Province

Silpies || = o SRRl Gl (02) 655-7777: 6359456 Mon~Fri. 8:30am~5:30pm
Solutions ,Inc.

Armenia

Azerbaijan

Georgia Firebird service centre +97 14 8837911 Sun.~Thu. 09:00 - 18:00

Kyrgyzstan

Tajikistan

Usbekistan | O"iKe Plus Private Enterprise | | 96471 5964450 Mon.~Fri. 09:00 - 18:00

Ltd

Turkmenistan

Technostar Service Centre

+(99312) 460733, 460957

Mon.~Fri. 09:00 - 18:00

Japan

T4V TFRAE=H—
RN — bk H—

.H_

0120-060-530

Mon.~Fri. 10:00 - 17:00
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8. Odstranovani problém0 a
Casté dotazy

8.1 Odstranovani problému

Na této strdnce jsou uvedeny problémy,
které mlZe odstranit uZivatel. Pokud problém
pretrvdvd i po vyzkousenf téchto resent,
kontaktujte zastupce sluzeb pro zdkazniky
spolecnosti Philips.

El B&Zné problémy

Zadny obraz (indikator LED napajeni nesviti)

»  Zkontrolujte, zda je napdjec( kabel pripojen
k elektrické zdsuvce a do zadnf ¢asti
monitoru.

*  Nejdrive zkontrolujte, zda se vypinac na
predni strané monitoru nachdzi ve OFF
(VYPNUTE) poloze a stisknéte jej do ON
(ZAPNUTE) polohy.

Zadny obraz (indikator LED napajenti je bily)

»  Zkontrolujte, zda je zapnuty pocitac.

»  Zkontrolujte, zda je kabel signdlu rddné
pripojen k pocitadi.

»  Zkontrolujte, zda nejsou ohnuté koliky na
pripojovac( strané kabelu monitoru. Pokud
ano, opravte nebo vymérite kabel.

*  Pravdépodobné je aktivovdna funkce rizenf
spotreby

Obrazovka rika

Attention

Check cable connection

»  Zkontrolujte, zda je kabel monitoru rddné
pripojen k pocitaci. (Rovnéz viz Strucnd
prirucka).

»  Zkontrolujte, zda nejsou ohnuté koliky
kabelu monitoru.

» Zkontrolujte, zda je zapnuty pocital.

Tlaéitko AUTO nefunguje
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Automatickd funkce je pouZitelnd pouze
v rezimu VGA-analogovy. Pokud vysledek
neni uspokojivy, mizete provést ru¢nf
Upravy prostrednictvim nabidky OSD.

© Poznimka
Automatickd funkce nenf pouzitelnd v
rezimu DVI-digitdInf, protoZe je zbytecnd.

Viditelné znamky koure nebo jiskreni

*  Neprovddéjte zddné kroky pro odstrarfiovdn{
problémd

*  Pro zajisténi bezpec¢nosti ihned odpojte
monitor od zdroje napdjenf

*  |hned kontaktujte zéstupce sluzeb pro
zékazniky spole¢nosti Philips.

E1 Problémy se zobrazenim

Obraz neni vystredén

*  Upravte polohu obrazu pomocf funkce
,Auto” v hlavnich ovlddacich prvecich OSD.

* Upravte polohu obrazu pomoci polozek
Phase/Clock (Féze/frekvence) v asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddac( prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.

Obraz se chvéje na obrazovce

»  Zkontrolujte, zda je kabel signdlu rddné a
bezpelné pripojen ke grafické desce nebo k
pocitaci.

Dochazi ke svislému blikani

*  Upravte polohu obrazu pomoci funkce
,Auto” v hlavnich ovlddacich prvcich OSD.

*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v Casti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddac( prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.

Dochazi k vodorovnému blikani




*  Upravte polohu obrazu pomocf funkce
,Auto' v hlavnich ovlddacich prvcich OSD.

*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v Casti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddacfi prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.

Obraz je rozmazany, nevyrazny nebo prilis
tmavy
*  Upravte kontrast a jas na obrazovce OSD.

,Dosvit", ,,vypaleni* nebo ,,zobrazeni duchi*

zlstane po vypnuti napajeni.

*  Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu mize
zpUsobit ,,vypdleni* obrazovky, rovnéz
zndmé jako ,,dosvit" nebo ,,zobrazen{
duchd". ,Vypéleni*, ,dosvit"* nebo
,,zobrazeni duchd" je dobre zndmy jev
u technologie paneld LCD. V mnoha
pripadech ,vypdleni”, , dosvit"* nebo
,,zobrazenf duchd" postupné zmizf po urcité
dobé& mimo provoz.

* Pred ponechdnim monitoru bez dozoru
vzdy aktivujte spori¢ obrazovky.

* Bude-li na vasem monitoru LCD zobrazen
nemeénici se staticky obsah, vzdy aktivujte
aplikaci pro pravidelnou obnovu obrazovky.

*  Véiné priznaky ,vypdleni”, ,dosvitu" nebo
,,zobrazenf duchl' nezmizi a nelze je
opravit. Na vySe uvedené poskozeni se
nevztahuje zdruka.

Obraz je zdeformovany. Text je nejasny nebo

rozmazany.

* Nastavte rozlieni zobrazeni pocitace na
stejny rezim, v jakém se nachdzf doporucené
nativni rozlisenf obrazovky monitoru.

Na obrazovce se objevuji zelené, cervené,

modré, tmavé a bilé tecky

*  Zbyvajicl body jsou normadlni viastnostl
tekutych krystald pouzivanych soucasnou
technologil. Dalsf podrobnosti viz pravidla
pro obrazové body.

Svétlo indikatoru ,,napajeni* je prilis silné a

rusi
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* MdZete nastavit intenzitu svétla indikdtoru
,napdjeni* v ¢asti Power LED (Indikdtor
LED napdjeni) v &asti Setup (Nastaven)

v OSD Main Controls (Hlavni ovlddaci prvky
nabidky OSD).

Potrebujete-li dalsi pomoc, viz seznam
Informacni strediska pro zdkazniky a kontaktujte
zéstupce sluzeb pro zdkazniky spole¢nosti Philips.

8.2 Obecné casté dotazy

OTAZKA 1: Kdyz nainstaluji svaij monitor, co
mam udélat, kdyz se na obrazovce
zobrazi zprava ,,Cannot display this
video mode* (Tento rezim videa
nelze zobrazit)?

Doporucené rozliseni pro tento

monitor: 19201080 pri 60 Hz.

*  Odpojte viechny kabely, potom pripojte
pocita¢ k monitoru, ktery jste pouzili predtim.

* V Start Menu (nabidce Start) operacniho
systému Windows vyberte Settings/Control
Panel (Nastaveni/Ovlddaci panely). V okné
Control Panel (Ovlddaci panely) vyberte
ikonu Display (Zobrazenf). Na panelu Display
Control (Zobrazeni — vlastnosti) vyberte kartu
,Settings' (Nastaveni). Na karté nastaven(

v poli oznaceném ,,desktop area" (pracovnf
plocha) presurite posuvnik na 1920%1080
obrazovych bodu.

* Klepnéte na ,,Advanced Properties” (Upresnit),
nastavte polozku Refresh Rate (Obnovovacf
frekvence) na 60 Hz a potom klepnéte na OK.

» Restartujte pocitac a zopakovanim kroku 2 a 3
ovérte, zda je pocita¢ nastaven na 19201080
pri 60 Hz.

*  Vypnéte pocitac, odpojte stary monitor a
znovu pripojte monitor LCD Philips.

*  Zapnéte monitor a potom zapnéte pocitac.

Odpovéd:

OTAZKA 2: Jaki je doporuéena obnovovaci
frekvence monitoru LCD?
Doporucend obnovovaci frekvence
u monitord LCD je 60 Hz. V pripadé
jakéhokoli ruseni na obrazovce ji
mUzete nastavit na 75 Hz a uvidite,

zda ruseni zmiz.

Odpovéd:



OTAZKA 3:

Co jsou soubory .inf a .icm
na disku CD-ROM? Jak Ize
nainstalovat ovladace (.inf a .icm)?

cisténi poutzijte izopropyl
alkohol. Nepouzivejte zddna jind
rozpoustédla, jako etylalkohol,

Odpovéd:  Jednd se o soubory ovladace etanol, aceton, hexan atd.
monitoru. Pri instalaci ovladact
postupujte podle pokynt OTAZKA 8: Lze ménit nastaveni barev
v uzivatelské prirucce. Pri monitoru?
prvni instalaci bude pocita¢ Odpovéd:  Ano, nastaven barev miZete zménit
pravdépodobné pozadovat prostrednictvim nabidky OSD podle
ovladace monitoru (soubory ndsledujicich krokd:
.infa .icm) nebo disk s ovladadi. »  Stisknutim tlacitka ,,OK" zobrazte nabidku
Postupujte podle pokynt a viozte OsD.
(doprovodny disk CD-ROM), ktery +  Stisknutim tlatftka ,,Down" (Sipka doli)
je soucdstf této sady. Ovladace vyberte volbu ,,Color* (Barva) a stisknutim
monitoru (soubory .inf a .icm) tlacitka ,,OK" prejdéte na nastaveni barev. K
budou nainstalovany automaticky. dispozici jsou i nastaven( (viz nize).
1. Color Temperature (Teplota barev):
OTAZKA 4: Jak mam upravit rozliseni? k dispozici je dvou nastavent: 6500K a
Odpovéd:  Dostupna rozliseni urcuje graficka 9300K. Pfi nastaveni v rozsahu 6500K
karta/ovladac grafiky a monitor. vypadajf barvy na panelu ,teplé s
Pozadované rozliSenf mizete vybrat ¢ervenobilym barevnym ténem", zatimco
v &asti Control Panel (Ovlddacf pfi nastaven( teploty 9300K vypadajf
panely) systému Windows® v &4sti barvy na panelu ,,studené s modrobilym
,Display properties" (Zobrazenf - barevnym ténem".
vlastnosti). 2. sRGB: standard pro zajisténi sprdvné
prenosu barev mezi riznymi zafizenimi
OTAZKA 5: Co kdyz se béhem nastaveni (napr. digiténi fotoapardty, monitory,
monitoru ztratim prostiednictvim tiskdrny, skenery atd.)
nabidky OSD? 3. User Define (Uzivatelské): uzivatel si mize
Odpovéd:  Jednoduge stisknéte tlacitko OK a zvolit vlastnf nastaven( barev upravenim
potom volbou ,,Reset" (Obnovit) Cervené, zelené a modré slozky.
obnovte vSechna plvodni nastaven( ,
wyrobce. ew P?znfimka: , o o
Mereni svétla barvy, které vyzaruje predmét pri
OTAZKA 6: Je obrazovka LCD odolnd proti zahrvani. Toto mefenf je vyjddieno v absolutnim
poskrabani? mérftku (stupné Kelvina). Niz3f teploty Kelvina,
Odpovéd’: Obecné se dopor‘uéuje napr‘ﬂdad 2004K, jSOU Cervené; Vyéé\/ teploty, jako
nevystavovat povrch panelu napriklad 9300K, jsou modré. Neutrdlni teplota je
nadmémym uderlm a chrdnit bila pri 6504K.
jej pred ostrymi nebo tupymi
predmeéty. P¥i manipulaci OTAZKA 9:  Lze pfipojit tento monitor LCD
s monitorem nevyvijejte na povrch k libovolnému pogitadi, pracovni
panelu zddny tlak ani silu. Mohlo by stanici nebo poéitadi Mac?
to negativné ovlivnit vase zarucnf Odpovéd: Ano.Vechny monitory LCD
podminky. Philips jsou pln& kompatibilni se
) standardnimi pocitaci, pocitaci
OTAZKA 7: Jak Ize Cistit povrch monitoru Mac a pracovnimi stanicemi. Pro
LCD? pripojeni monitoru k systému
OdeVéd’Z Pro bézné cisténi pouzijte Cisty Mac mUzZe byt zapotrebi kabelovy

a mékky hadrik. Pro dikladné
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adaptér. Dal3i informace vdm



poskytne nejblizsi obchodnf
zastupce Philips.

OTAZKA 10: Jsou monitory Philips LCD
vybaveny technologii Plug-and-
Play?

Odpovéd: Ano, tyto monitory jsou
kompatibilni s technologi Plug-
and-Play v operacnim systému
Windows 7/ Windows 8.1, Vista,
XP NT, Mac OSX a Linux.

OTAZKA 11: Co znamena Ipéni obrazu,
vypaleni obrazu, dosvit nebo
,»duch® v souvislosti s panely
LCD?

Odpovéd: Dlouhodobé neprerusované
zobrazeni nehybného nebo
statického obrazu mdze zpUsobit
,Vvypdleni* obrazovky, rovnéz
zndmé jako ,,dosvit" nebo
.zobrazenf duchd*. , Vypdleni*,
,,dosvit"* nebo ,,zobrazeni duchd*
je dobre zndmy jev u technologie
paneld LCD.V mnoha pripadech
Vypdlenf*,, dosvit" nebo
,,zobrazeni duch(" postupné zmizf
po urcité dob& mimo provoz.
Pred ponechdnim monitoru bez
dozoru vzdy aktivujte sporic
obrazovky.

Bude-li na vaSem monitoru LCD
zobrazen neménicf se staticky
obsah, vzdy aktivujte aplikaci pro
pravidelnou obnovu obrazovky.

) Vystraha

Selhdni aktivace sporice obrazovky nebo aplikace

pro pravidelné aktualizovani obrazovky mize mit

za nasledek vazné priznaky ,vypdleni”, ,, dosvitu"

nebo ,,zdvojeného dosvitu", které nezmizi a

nelze je opravit. Na vyse uvedené poskozeni se

nevztahuje zaruka.

OTAZKA 12: Pro¢ se na displeji nezobrazuje
ostry text a pro¢ maji
zobrazené znaky zubaté okraje?

Odpovéd: V4as monitor nejlépe pracuje
pri svém nativnim rozlisenf
1920x1080 pfi 60 Hz. Pouzivejte
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toto rozlisenf pro dosazenf
optimdlniho zobrazenf.
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